
 

 
 
 
 
 
 
 

CASIO 
IT-300 Series 

 Quick Start Guide 
 

(Version 1.01) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CASIO Computer Co., Ltd. 
Copyright ©2011. All rights reserved. 

 

March 2011 

 



 

 

Table of the Contents 
Editorial Record 4 
Preface 5 

Chapter 1. Product Overview 6 
1.1 Features at a Glance 6 
1.2 Library 8 
1.3 Development Manuals 9 

Chapter 2. Prerequisites 10 
2.1 Skills Required 10 
2.2 Hardware Required 11 
2.3 Software Required 13 

Chapter 3. Installing BDK to PC 14 
3.1 Application Development 14 
3.2 Installing CASIO BDK Files 15 
3.3 Installing Library 17 
3.4 Installing Online Help 18 

Chapter 4. Connecting to USB and Charging Unit 19 
4.1 HA-J65US 19 

Chapter 5. Connecting the IT-300 to PC 20 
5.1 Connection via USB Cradle 21 
5.1.1 ActiveSync via USB 22 
5.1.2 Windows Mobile Device Center via USB 22 
5.2 Connection via WLAN 23 
5.3 Accessing Shared Network Drive on Your LAN 28 
5.4 Direct TCP/IP Connection from Visual Studio 29 

Chapter 6. Setting Up the Development Environment 31 
6.1 Installing CAB Files 31 
6.2 Visual Studio 2005 32 

Chapter 7. Device Emulator 33 
7.1 Software Required 33 
7.2 Starting Up the Device Emulator 35 
7.3 Using the Device Emulator 36 
7.3.1 IT-300WM Device Emulator 36 
7.3.2 I/O Simulator 37 
7.3.3 Connecting via ActiveSync 42 
7.4 Debugging Applications 44 

Chapter 8. Visual Studio 46 
8.1 Developing in C++ 47 
8.2 Developing in VB 51 
8.3 Developing in C# 53 

Chapter 9. Resources 56 

2 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
No part of this document may be produced or transmitted in any form or by any means, electronic 
or mechanical, for any purpose, without the express written permission of CASIO Computer Co., 
Ltd. in Tokyo Japan. Information in this document is subject to change without advance notice. 
CASIO Computer Co., Ltd. makes no representations or warranties with respect to the contents or 
use of this manual and specifically disclaims any express or implied warranties of merchantability 
or fitness for any particular purpose. 

 
© 2011 CASIO Computer Co., Ltd. All rights reserved. 

3 



 

 

Editorial Record 
Manual 
Version 

no. 
Date edited Page Content 

1.00 January 2011 all Original version 
1.01 March 2011 6 OS description name is updated. 

    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    

 

4 



 

 

Preface 
This guide clearly and concisely sets out the information developers need to know to get started with 
the CASIO IT-300 series handheld terminals with the integrated Windows Embedded Handheld 6.5 
OS. The best methods of connecting to your development system are covered and step by step 
instructions for installing and testing the CASIO Basic Development Kit (BDK) are included. 
 
The purpose of this guide is to get you to the point where you can start development; you should 
refer to the library manuals for detailed information on the specific APIs. 
 
The words, "the terminal", "the IT-300", "the IT-300 series", and "IT-300 device", used in this 
reference manual mean IT-300 series handheld terminal with the integrated Windows Embedded 
Handheld as its OS unless otherwise noted. 
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1. Product Overview 

1.1 Features at a Glance 
The IT-300 has been designed using the new concept of the Human-centered Design Processes and 
is capable of performing a wide variety of powerful functions. 
The following is a brief overview of the features available on the IT-300 series handheld terminals. 
For further detail on the hardware specifications, refer to IT-300 Series Hardware Manual. 
 
Outstanding development environment  
• Microsoft® Windows Embedded Handheld 6.5 English Version as the built-in OS 
• Visual Studio 2008 
• Visual Studio 2005 

 
Various communication systems 
• Built-in ultra-small WLAN module compatible with the IEEE802.11b/g standard 
• Bluetooth® Version 2.0 
• Serial interface with USB version 1.1 (Host/Client) 

 
Small size, light weight 
• Dimensions : Approx. 75.7 (W) x 154.6 (D) x 19.6 (H) mm 
• Weight  : Approx. 212g  

 
Improved durability 
• Impact resistance   : 1.5 m in height * 
• Dust/Water-splash proof : IP54 level (compliant with IEC60529 International Standard) 

 
* The drop durability height is a measured value resulting from actual testing. It does not necessarily guarantee the 

product from damage. 
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Scanning industrial standard bar code symbologies 
• Readable bar code symbologies with laser scanner: 

EAN8, EAN13, UPC-A/E, Codabar (NW-7), CODE39, CODE93, CODE128/EAN128, ITF, 
MSI, IATA, Industrial 2of5, GS1 DataBar Omnidirectional (RSS-14), GS1 DataBar Limited 
(RSS Limited), GS1 DataBar Expanded (RSS Expanded), GS1 DatBar Stacked (RSS-14 
Stacked), GS1 DataBar Expanded Stacked(RSS Expanded Stacked) 

 
CPU, Memory 
• High-performance CPU 

Marvell® PXA320 Application Processor (runs at maximum 624 MHz) 
• Large-capacity memory 

RAM : 256 MB 
F-ROM : 256 MB 

7 



 

 

1.2 Library 
The IT-300 Basic Development Kit ("BDK") provides various libraries including those listed in the 
table. 
 
Table 1.1 

Library Description C++ VB
C# 

System Library Library that is used to control the system. Yes Yes
Laser Scanner Library Library that is used to control the built-in laser scan engine. Yes Yes
JPEG Library Library that is used to handle and manipulate JPEG image 

functions. 
Yes - 

FLINK Library Library that is used to control and carry out 
transmission/reception of files between PC and other device. 

Yes Yes

Bluetooth Library Library that is used to control the built-in Bluetooth module. Yes Yes
Note: 
The abbreviations used in the table are; 

C++ : Visual C++ 
VB : Visual Basic .NET 
C# : Visual C# .NET 

 
 
Table 1.2 shows each file name of the Dynamic Link Library and Dynamic Link Class Library. 
 
Table 1.2 

Library Dynamic Link Library Dynamic Link Library 
(Class Library) 

System Library SystemLib.dll SystemLibNet.dll 
Laser Scanner Library OBReadLib.dll OBReadLibNet.dll 
JPEG Library JpegCe.dll None 
FLINK Library FlinkLib.dll MoFlinkLib.dll 
Bluetooth Library BTLib.dll BluetoothLibNet.dll 
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1.3 Development Manuals 
The IT-300 Basic Development Kit ("BDK") provides various development reference manuals as 
described in the table below. 
 
Table 1.3 

Development Manual Description 
Quick Start Guide This reference manual. 
Software Manual Reference manual that describes software specifications in detail for all 

the software integrated in IT-300 handheld terminal. 
Hardware Manual Reference manual that describes hardware specifications in detail on 

each dedicated option and IT-300 handheld terminal 
System Library Manual Reference manual that describes individual functions in detail for System 

Library. 
Laser Scanner Library Manual Reference manual that describes individual functions in detail for Laser 

Scanner Library. 
JPEG Library Manual Reference manual that describes individual functions in detail for JPEG 

Library. 
FLINK Library Manual Reference manual that describes individual functions in detail for FLINK 

Library. 
Bluetooth Library Manual Reference manual that describes individual functions in detail for 

Blueooth Library. 
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2. Prerequisites 

2.1 Skills Required 
The following skills are required by developers aiming to develop application software for the 
IT-300 terminal. 
• Windows programming 
• A good knowledge of one or more of the following. 

- Visual C++ 
- Visual Basic .NET 
- Visual C# 
- Browser based applications (not covered in this guide) 

 
The following skills or experience are also desirable. 
• Windows CE devices 
• ActiveSync 
• Some networking experience 
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2.2 Hardware Required 
The following models of the IT-300 series and dedicated options are available. 
 
Table 2.1 List of available models 

Model no. Scanner Extension slot WLAN 
(802.11 b/g) Bluetooth Remarks 

IT-300-15E Laser microSD Yes Yes  
IT-300-15C-CN Laser microSD Yes Yes Chinese OS 
IT-300E-35E* Linear microSD -- Yes  

Notes 
- “-CN” in the “Model no.” box denotes that the model is dedicated for China only. 

  Model with “*” at its model number is for USA and Canada only.  
 
Table 2.2 List of options 

Option Product Model no. Remark 
USB Unit HA-J65US 

HA-J65US-CN 
 
for China 

Mini USB cable HA-J80USBM 
HA-J80USBM-CN 

 
for China 

Mini USB Host conversion cable HA-J81USBH 
HA-J81USBH-CN 

 
for China 

Battery Pack HA-D20BAT-A 
HA-D20BAT-A-CN 

 
for China 

Dual Battery Charger HA-D32DCHG 
HA-D32DCHG-CN 

 
for China 

AC adaptor for Dual Battery Charger 
(for HA-D32DCHG) 

AD-S42120B-N 
AD-S42120BE-CN 

without power cable accompanied
for China 

AC adaptor for USB Unit 
(for HA-J65US) 

AD-S15050B-N 
AD-S15050BE-CN 

without power cable accompanied
for China 

Screen Protect Sheet HA-J90PS5  
AC-CORD-EU for Europe 
AC-CORD-US for USA/Canada 
AC-CORD-TW for Taiwan 
AC-CORD-KR for Korea 

Power Cable  
(for AD-S42120B-N, AD-S15050B-N) 

AC-CORD-AU for Australia/New Zealand 
Note: 
“-CN” in the “Model no.” box denotes that the model is dedicated for China only. 
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External views of IT-300 and dedicated options 
 

 

 

Figure 2.1 
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2.3 Software Required 
The following software tools and libraries are required in order to develop software for the IT-300. 
Please ensure that you download or purchase the correct Microsoft tools as appropriate. 
 
PC Operating System 
• Microsoft Windows 2000 Professional Service Pack 4 or later 
• Or Microsoft Windows 2000 Server Service Pack 4 or later 
• Or Microsoft Windows XP Professional Service Pack 2 or later 
• Or Microsoft Windows 2003 Server Service Pack 1 or later 
• Or Microsoft Windows Vista (Business / Ultimate ) 
• Or Microsoft Windows 7 
• Or Microsoft Windows Server 2008 

 
Development platform 
Table 2.1 

Programming 
Language Development Platform 

Visual C++ 
Visual Basic .NET 
Visual C# 

Microsoft Visual Studio 2005 + SP1 or later 
Microsoft Visual Studio 2008 + SP1 or later 

 
Communication Software 
• Microsoft ActiveSync 4.5 (or later) 

Download for free from; 
http://www.microsoft.com/downloads/details.aspx?familyid=9E641C34-6F7F-404D-A04B-DC0
9F8141141&displaylang=en 

• Microsoft Windows Mobile Device Center 6.1 (for Windows Vista or later) 
Download for free from; 
http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F
07AAA1914&displaylang=en 

 
SDK 
• Microsoft Windows Mobile 6 Professional SDK (Mandatory) 

Download for free from; 
http://www.microsoft.com/downloads/details.aspx?familyid=06111A3A-A651-4745-88EF-3D4
8091A390B&displaylang=en 

• Windows Mobile 6.5.3 Professional DTK (Mandatory) 
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=c0213f68-2e01-4e5c-a8b2-35e
081dcf1ca&displaylang=en 

• Microsoft Windows Mobile 6.5 Developer Tool Kit (Not mandatory) 
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=20686a1d-97a8-
4f80-bc6a-ae010e085a6e 

 
CASIO IT-300 BDK 

Download the IT-300 BDK from 
http://www2.casio.co.jp/system_en/pa/PADealer/  
(The site requires your user name and password. Enter your user name and password as issued by CASIO.) 
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3. Installing BDK to PC 

3.1 Application Development 
This chapter explains about what you need to set up for the development environment before 
starting your application development. 
 
1. Installing Development Platform 

Install Microsoft's development platform which supports Visual Studio 2008 and Visual Studio 
2005.  
Install SDK (Microsoft Windows Mobile 6 Professional SDK) 
For detail, refer to Chapter 2.3 "Software Required". 
Install DTK (Microsoft Windows Mobile 6.5.3 Professional DTK) 

 
2. Installing CASIO BDK to PC 

Install CASIO's BDK ("Basic Development Kit") and various libraries if necessary. For 
installation method, refer to Chapter 3.2 "Installing CASIO BDK Files". 

 
3. Connecting IT-300 to PC (via either ActiveSync or Windows Mobile Device Center) 

Connect the IT-300 to PC via Microsoft's ActiveSync (for Windows XP or any other OS before 
Windows XP) or via Windows Mobile Device Center (for Windows Vista). For connection 
method, refer to Chapter 5 "Connecting the IT-300 to PC". 

 
4. Setting up the Development Environment 

Transmit the CASIO's libraries to the IT-300. 
For detail, refer to Chapter 6 "Setting Up the Development Environment". 

 
5. Installing the Device Emulator 

Install the Device Emulator for the IT-300. For installation method, refer to Chapter 7 "Device 
Emulator". If not necessary to install, go to "6. Application Development" below. 

 
6. Application Development 

Now, the application development environment is set up and your development with the 
development platform can be started. After application is developed, transmit it to the Device 
Emulator or an actual terminal of the IT-300 via ActiveSync or Windows Mobile Device Center 
for check on the operability. For application development method and transmitting your 
application, refer to Chapter 8 "Visual Studio". 
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3.2 Installing CASIO BDK Files 
Download the CASIO IT-300 BDK installation CD image file from the following site and write it 
to a CD-ROM media. 
http://www2.casio.co.jp/system_en/pa/PADealer/  
(The site requires your user name and password. Enter your user name and password as issued by CASIO.) 

 
Notes: 
• If you had already installed IT-300 BDK Ver. 1.xx, be sure to uninstall it before installing Ver. 

2.xx. 
• If any file of the IT-300WM BDK Ver. 1.xx is remained in the following folders after 

uninstalling, delete it manually. 
C:\Program Files\CASIO\MBSYS 
C:\Program Files\Windows CE Tools\wce500 
 

• If your PC runs in the Windows Vista or later OS, first you must disable the User Account 
Control ("UAC") by following the process below before installing the CASIO BDK Files. 

- Navigate to Control Panel → User Accounts → Enable or Disable the User 
Account Control. Remove the check on User Account Control (UAC) to protect your 
PC, and then click OK button. 
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Installation Steps 
1. When the CASIO IT-300 BDK CD-ROM is inserted in the drive of PC, the following menu 

screen appears automatically. 

 

Figure 3.1 
 
2. Click Installation List in Figure 3.1. The installation screen appears. 

 
Figure 3.2 
 
3. Choose the component you wish to install in the screen. 
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3.3 Installing Library 
The IT-300 Library is available for the below development platforms. 
 
• Microsoft Visual Studio 2008 
• Microsoft Visual Studio 2005 

 
Notes: 
1. The Library header file (*.h) and the Import library file (*.lib) are installed in the following 

folders respectively. 
C:\Program Files\CASIO\MBSYS\include : Header file 
C:\Program Files\CASIO\MBSYS\lib\ARMV4I : Import library file 

2. The Class library DLL file (*.dll) is installed in the following folder. 
C:\Program Files\CASIO\MBSYS\WindowsCE 

3. When the Library is installed in PC, the Help file (*.chm) is installed in the following folder. 
C:\Program Files\CASIO\MBSYS\HELP 
 
The Help file can be accessed by navigating to Start menu → All Programs → CASIO Basic 
Development Kit → Help 
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3.4 Installing Online Help 
Besides the Help file described in the previous page, the Online Help is also available for the below 
development platforms. The installation of the Online Help is initiated in the Installation List. 
 
• Microsoft Visual Studio 2008 
• Microsoft Visual Studio 2005 

 
After the installation is complete, Microsoft Visual Studio starts up. The Online Help file can be 
accessed by navigating to Help → Contents menu. 
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4. Connecting to USB and Charging Unit 

4.1 HA-J65US 
Power to IT-300 supply from USB and Charging Unit. 
 
1. Insert USB and Charging Unit into IT-300 bottom connection 

 
Figure 4.1 

 
2. After connection, please confirm exactly lock IT-300 by both of stoppers. 

 
Figure 4.2 

 
3. Connect mini USB cable with USB Unit, then connect to PC. 

 
Figure 4.3
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5. Connecting the IT-300 to PC 
To make connection establishment with PC, use one of the methods, depending on the OS your PC 
runs, described below. 
 
• ActiveSync 4.5 or a later version (for Windows XP or any other OS earlier) 

Use the ActiveSync to connect the IT-300 to PC if the PC runs in Windows XP or other OS 
earlier than Windows XP. The ActiveSync can be downloaded at the URL below. 
http://www.microsoft.com/downloads/details.aspx?familyid=9E641C34-6F7F-404D-A04B-DC0
9F8141141&displaylang=en 

 
• Windows Mobile Device Center 6.1 or a later version (for Windows Vista or later) 

Use the Windows Mobile Device Center to connect the IT-300 to PC if the PC runs in Windows 
Vista OS. The Windows Mobile Device Center ("WMDC") can be downloaded at the URL 
below. 
http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F
07AAA1914&displaylang=en 
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5.1 Connection via USB Cradle 
Before making connection using ActiveSync or Windows Mobile Device Center, check the USB 
Connection settings on the terminal. 
 
Follow the steps below: 
1. Navigate to Start → Settings → System tab → USB Connection. 
2. Tap Connect Utility tab. 

 
Figure 5.1 
 
3. Confirm that "Windows Mobile Device Center/ActiveSync" is selected. If not, select the radio 

button and tap ok. 
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5.1.1 

5.1.2 

ActiveSync via USB 
To establish connection via USB interface with PC runs in Windows XP or any other OS earlier 
than Windows XP, use ActiveSync. 
 
Follow the steps below: 
1. Install ActiveSync to the PC, if not installed. 
2. Connect the USB cable to the PC and the other end to the USB Cradle and also the AC adaptor to 

the USB Cradle. 
3. Make sure the selector switch on the back of the cradle is set to position B. 
4. Put the IT-300 on the cradle and confirm that the green LED on the front of the cradle is lit. If not, 

be sure the IT-300 is positioned firmly on the cradle. 
5. Follow a message appeared in the ActiveSync on the PC. 
 
 

Windows Mobile Device Center via USB 
To establish connection via USB interface with PC runs in Windows Vista, use Windows Mobile 
Device Center ("WMDC"). 
 
Follow the steps below: 
1. Install WMDC to the PC, if not installed. 
2. Connect the USB cable to the PC and the other end to the USB Cradle and also the AC adaptor to 

the USB Cradle. 
3. Make sure the selector switch on the back of the cradle is set to position B. 
4. Put the IT-300 on the cradle and confirm that the green LED on the front of the cradle is lit. If not, 

be sure the IT-300 is positioned firmly on the cradle. 
5. Follow a message appeared in the WMDC on the PC. 
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5.2 Connection via WLAN 
To establish communication between the IT-300 with WLAN module integrated (see Table 2.1 for 
applicable models) and PC via WLAN configuration, follow the steps, 1 to 6, below to set up a 
WLAN configuration on the IT-300. After setting up the configuration, be sure to perform a site 
survey prior to starting communication via WLAN. 
 
1. Navigate to Start → Settings → Connection tab→ WLANConfig and then tap IP tab. 

 
Figure 5.2 

 
Table 5.1 

Parameter Description 
Enable DHCP or Configure IP Determines "Enable" or "Disable" for DHCP. 
IP Determines IP address. 
MASK Determines subnet mask. 
GateWay Determines default gateway. 
DNS1 Determines primary DNS address. 
DNS2 Determines secondary DNS address. 
WINS1 Determines primary WINS address. 
WINS2 Determines secondary WINS address. 

 
If any of the settings in Figure 5.2 is omitted, the process described in the following table will 
automatically take place in the field. 
 
Table 5.2 

Parameter Nothing is set (DHCP) "Configure IP" is set 
Enable DHCP or 
Configure IP 

"Enable DHCP" is assumed. "Configure IP" is set. 

IP Does not determine IP address. Entered address is set as is. 
MASK Does not determine subnet mask. Entered address is set as is. 
GateWay Does not determine gateway. Entered address is set as is. 
DNS1 Does not determine primary DNS address. Entered address is set as is. 
DNS2 Does not determine secondary DNS address. Entered address is set as is. 
WINS1 Does not determine primary WINS address. Entered address is set as is. 
WINS2 Does not determine secondary WINS 

address. 
Entered address is set as is. 
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2. Tap Basic tab. Set up each parameter in the tab by referring to the descriptions for the 

parameters in Table 5.3. 

 
Figure 5.3 

 
Table 5.3 

Parameter Description 
SSID Enter the SSID of the network you want to connect to. 

Disable None. 
WEP Open in Authentication field. 

Security 

WPA 
WPA2 

PSK in Authentication field (if selected, the Key field must be set also.) 
EAP-PEAP in Authentication field 
EAP-TLS in Authentication field 

Key Enter 26 (maximum) alphanumeric digits (13 hex pairs) in the Key field if 128 bit 
radio button is selected. Or, enter 10 (maximum) alphanumeric digits (5 hex pairs) in 
the Key field if 64 bit radio button is selected. 
 
The field displays the number of characters that have been entered. 
***** in the field implies that the key has been extracted from the ini file. If ***** in 
the field is edited, a new key has been deemed to be set. Or, if it has never been edited, 
the key extracted from the ini file becomes effective as is. 

 
If EAP-PEAP radio button in Authentication field is selected, tap the EAP-Properties button that 
appears when selecting the EAP-PEAP radio button to set also the following parameters. 
Table 5.4 

Parameters in 
EAP-Properties screen Description Default 

User name Input a user name in alphanumeric (maximum 100 
alphanumeric). 

None 

Password Input a password in alphanumeric (maximum 100 
alphanumeric). 
 
***** in the field implies that the password has been 
extracted from the ini file. If ***** in the field is 
edited, a new password has been deemed to be set. 
Or, if it has never been edited, the password extracted 
from the ini file becomes effective as is. 

None 

Domain Input a domain in alphanumeric (maximum 100 
alphanumeric). 

None 

Validate server 
certificate 

 Set up the requisition for server certificate. 
With check mark   : certificate is required. 
Without check mark: certificate is not required. 

Certificate is not necessary
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If EAP-TLS radio button in Authentication field is selected, tap the EAP-Properties button that 
appears when selecting the EAP-TLS radio button to set the following settings. 
 
Table 5.5 

Parameters in 
EAP-Properties screen Description Default 

User name Input a user name in alphanumeric (maximum 100 
alphanumeric). 

None 

Certificate Select a client certificate installed already (maximum 
100 alphanumeric). 
 
Search button in the field will display a list of 
installed client certificates. Select one by highlighting 
it. 

None 

Domain Input in alphanumeric (maximum 100 alphanumeric) None 
Validate server 
certificate 

Set up the requisition for server certificate. 
With check mark   : certificate is required. 
Without check mark : certificate is not required. 

Certificate is required. 

 
3. Tap WLAN tab. 

 
Figure 5.4 

 
Table 5.6 

Field / Radio 
Buttons Description Default 

On Enable power to the integrated WLAN module. Yes Adapter power 
Off Disable power to the integrated WLAN module.  
Enable Enable power save mode for the WLAN module. Yes Power save 
Disable Disable power save mode for the WLAN module.  
b Set up IEEE802.11b standard effect.  Standard 
b/g Set up IEEE802.11b/g standard effect. Yes 
No roaming Set up "-100 dBm" for roaming starting threshold level, 

a level where communication via WLAN is practically 
impossible, so that roaming should not be carried out.   

 

Default 
 

Set up "-78 dBm" for the roaming starting threshold 
level. 

Yes 

RSSI Level for 
initiating roaming 

High 
 

Set up "-72 dBm" for roaming starting threshold level, 
for faster (more frequent) roaming 
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4. Tap Detail Settings tab. 

 
Figure 5.5 

 
Table 5.7 

Field / Radio Buttons Description Default 
hide popup Hides popup window when WLAN is not 

connected to a network. 
Yes 

 
When WLAN is not 
connected to a 
network show popup Shows popup window when WLAN is not 

connected to a network. 
 

With check mark : enable the setting.  Enable AdHoc network setting 
Without check mark : disable the setting. Yes 
With check mark : enable the setting.  Enable all authentication settings 
Without check mark : disable the setting.  Yes 

Inifile comment Enter a comment of up to 100 characters to be 
written in the ini file. 

None 
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5. If OK button is clicked, the screen in Figure 5.6 appears. Tap OK button to perform a reset on the 

terminal so that the setting takes effect. 

 
Figure 5.6 

 
6. Check to make sure that the connection has been established using the NetSearch utility, and 

then navigating to the Ping function in there. Enter HostName first and then tap Ping to check 
that you are connected to the network correctly. 
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5.3 Accessing Shared Network Drive on Your LAN 
Assuming you have a valid network connection established, you can access shared drives on your 
PC from the File Explorer on the IT-300. The following shows the steps to initiate this. 
 
1. Configure a network connection on the IT-300. 
2. Double tap My Device. 
3. Type \\xxxx\ where xxxx is the network name of the PC. 
4. A network logon dialog box will appear. Enter a valid User ID, Password and Network Domain. 
5. Any shared network drives on the target PC will be displayed and you will be able to copy files 

freely between them and the IT-300. 
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5.4 Direct TCP/IP Connection from Visual Studio 
If you have a network connection to the IT-300 (for example, via WLAN) then you can establish a 
direct link to the development PC without using ActiveSync. 
 
For Visual Studio 2005 
1. Download the files listed below to the IT-300. 

- Clientshutdown.exe 
- ConmanClient2.exe 
- CMAccept.exe 
- DeviceDMA.dll 
- eDbgTL.dll 
- TcpConnectionA.dll 

 
The source folder in the PC: 

C:\Program Files\Common Files\Microsoft Shared\CoreCon\1.0\Target\wce400\armv4i 
The destination folder in the IT-300: 

\Windows 
 
2. Run ConmanClient2.exe on the IT-300. 
3. Set the device IP address in Visual Studio 2005.  
4. Navigate to Tools in the main menu of Visual Studio 2005 → Options… → Device Tools 

→ Devices.  
5. Choose Windows Mobile 6 Professional Device in the pull-down menu of Devices: and 

click Properties…. 
6. Click Transport: to access Configure… and set up Device IP address as shown in Figure 

5.7. 

 
Figure 5.7 

 
7. Run CMAccept.exe on the IT-300. 
8. Navigate to Tools in the main menu of Visual Studio 2005 → Connect to Device…. 
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9. Choose Windows Mobile 6 Professional Device in the list of Devices: and click 

Connect button. The screen in Figure 5.8 if appear indicates the success of connection 
establishment. 

 
Figure 5.8 
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6. Setting Up the Development Environment 

6.1 Installing CAB Files 
1. After installing the library files, the CAB files in Table 6.1 will be installed in the folder 

below. 
C:\Program Files\CASIO\MBSYS\CAB 

 
Table 6.1 

Library CAB file Preinstalled 
System Library en_SystemLibWM.ARMV4I.CAB Yes 
Laser Scanner Library en_OBReadLibWM.ARMV4I.CAB Yes 
JPEG Library enJPEGWM.ARMV4I.CAB Yes 
FLINK Library en_FlinkWM.ARMV4I.CAB Yes (note 2) 
Bluetooth Library BTLIBIT800WME.100.CAB No (note 3) 

Notes: 
1. The library with "Yes" in "Preinstalled" column is preinstalled in the IT-300 and in the 

Device Emulator. Thus, it is not necessary to install it, unless it has been updated or 
changed. 

2. The CAB file, en_FlinkWM.ARMV4I.CAB, in the table does not operate for the IT-300. 
Use the FlinkLib.dll installed by default in the terminal. 

3. BTLIBIT300WME.100.CAB file will be released as IT-300 Bluetooth patch file. 
 

2. Copy all the CAB files in Table 6.1 to any folder on the IT-300 via ActiveSync. 
3. Carry out each CAB file. 
4. When the installation starts, the installation status will appear. 
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6.2 Visual Studio 2005 
Follow the steps in Chapter 5 "Connecting the IT-300 to PC" before checking the steps below to 
confirm that you can connect to the IT-300 from Visual Studio 2005. 
 
1. Establish connection with the IT-300 via ActiveSync. 
2. Open the application project for VB or C# in Visual Studio 2005. 
3. Choose Windows Mobile 6 Professional Device in the pull-down menu box. 

 
 
Figure 6.1 

 
4. Click the button shown in the red box below (see Figure 6.2) to make sure that Visual Studio 

2005 has recognized the connection established with the IT-300 via ActiveSync. If it does not, 
start up ActiveSync again to establish connection. 

 
Figure 6.2 

 
5. You will now be able to deploy solutions and also debug applications on the attached IT-300 

using the Visual Studio 2005 debugging features. 
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7. Device Emulator 
The Device Emulator provides application developers with an environment that, without having 
the actual terminal available, allows them to debug basic functions and performance of an 
application at source level by stepping through the code. 
 

7.1 Software Required 
The Device Emulator requires the software(s) listed below before installing the emulator. 
 
• ActiveSync 4.5 or a later version (If required) 

http://www.microsoft.com/downloads/details.aspx?familyid=9E641C34-6F7F-404D-A04B-DC0
9F8141141&displaylang=en 

• Visual Studio 2008 or Visual Studio 2005 (Mandatory) 
• Microsoft Device Emulator 3.0 (If required) 

http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=a6f6adaf-12e3-4
b2f-a394-356e2c2fb114 

• Windows Mobile 6 Professional SDK Refresh 
http://www.microsoft.com/downloads/details.aspx?familyid=06111A3A-A651-4745-88EF-3D4
8091A390B&displaylang=en 

• Windows Mobile 6 Emulator Image for CASIO IT-300 (Mandatory) 
• IO Simulator (Mandatory) 
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Case of using after Windows Vista OS 

If you use OS after Windows Vista (Windows 7 or Windows Server 2008), please set device 
emulation and I/O simulator as administrator. 
Please check “Run this program as an administrator” of property from opening Explorer. 
(Ex. Execute I/O simulator in Windows Vista as administrator.) 
 

 
Figure 7.1 

 
 
These program have installed the following location as default setting. 
• Device emulator 

C:\Program Files\Microsoft Device Emulator\1.0\DeviceEmulator.exe 
• I/O simulator 

C:\Program Files\Common Files\CASIO\Emulator\DevIoSim.exe 
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7.2 Starting Up the Device Emulator 
After installing all required software described in Chapter 7.1, follow the steps below to start up the 
Device Emulator on your PC. 
 
1. Navigate to Start menu → All Programs → CASIO Device Emulator and click IT-300WM. 
2. Make sure that the IT-300WM Device Emulator has started up on the screen. See Figure 7.2. 
3. Navigate to Start menu → All Programs → CASIO Device IO Simulator and click IO 

Simulator. 
4. Make sure that the IO Simulator has started up on the screen. See Figure 7.3. 
5. When both Figure 7.2 and Figure 7.3 appear on your PC, you are ready to use the emulator. 
 

  
Figure 7.2  IT-300WM Emulator Figure 7.3  I/O Simulator 

 
 
 
 
Terminology of Emulator and Simulator; 
The Emulator described in this reference manual is a software application that behaves in a very 
similar way to the actual device by imitating individual hardware components or protocols present in 
the actual hardware.  
On the other hand, the Simulator is also a software application that logically integrates application 
programming interfaces ("API") and certain other functions to allow debugging of the application 
program using external events. The Emulator performs in a pseudo CPU and hardware 
environment and it is impossible for the application to recognize whether it is in the actual device 
environment or pseudo environment. However, actions carried out by the Simulator are not as 
alike to those performed by actual components but merely mimic them very closely. 
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7.3 Using the Device Emulator 

7.3.1 IT-300WM Device Emulator 
The IT-300WM Device Emulator emulates various operations carried out by the actual IT-300 on 
the PC's screen such as mouse operation, input on PC's keyboard, displaying execution of 
applications, and operations by actual devices such as the scanner. Figure 7.4 shows an emulated 
IT-300 on the screen of a PC. 

 
Figure 7.4 
 
Key Input 
The emulator offers key input capability similar to that of the actual IT-300. For instance, a key on 
the emulated keyboard of IT-300 on the screen (see Figure 7.4) can be clicked with PC mouse as 
well as key input made directly on the PC's keyboard. 
 
Reading Bar Codes 
The emulator enables bar codes pre-registered in the I/O Simulator (see Figure 7.3) to be input when 
clicking Trigger key on the emulated keyboard (see Figure 7.4). Note however that the Trigger key 
must be continuously pressed for a second or more otherwise an incorrect key input may result. 
 
Sound 
The emulator offers beep and sound capability similar to that of the actual IT-300. 
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7.3.2 I/O Simulator 
The I/O Simulator simulates registration of bar codes, generation of low battery warning, detection 
of terminal being mounted on the cradle.  
 
Registration of bar code symbologies 
1. Registration 

Click ADD1D or ADD2D button (circled in red in Figure 7.5) to go into the bar code 
registration mode. 

 
Figure 7.5 

 
2. Bar code registration 

Choose a bar code symbology in the Code Type pull-down menu that you wish to register in 
the I/O Simulator. 

 
Figure 7.6 
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3. Registration of bar code and note 

Enter bar code data in the Code field (see Figure 7.7) and a note about the bar code in the 
Note field if necessary. Click OK button to complete the bar code registration. 

 
Figure 7.7 
 

4. Completion of registration 
After completion of the bar codes registration, the screen in Figure 7.8 shows a list of bar codes 
that have been registered in the I/O Simulator. Prior to debugging with the Device 
Emulator, make sure that you register all bar codes you wish to use in debugging. 

 
Figure 7.8 
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5. Editing registered bar code content 

Highlight a bar code in the list of registered bar codes (see Figure 7.8) and click Edit button. 
Figure 7.9 appears for editing the bar code and its information.  

 
Figure 7.9 
 

6. Deleting registered bar code content 
Highlight a bar code in the list of registered bar codes (see Figure 7.8) and click the Del button. 
Dialogue screen in Figure 7.10 appears for you to confirm the deletion. If it is okay to delete, 
click Yes button, otherwise click No button. 

 
Figure 7.10 
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Detection of Terminal in Cradle and Low Battery Warning 
If you check the I/O Box and Low Battery boxes in STATE SETTING field (see Figure 7.11), the 
Simulator simulates the respective events in the emulator.  

 
Figure 7.11 
 

I/O Box 

If this box is checked, a notification is issued that the connection between the IT-300WM Device 
Emulator and USB Unit has been established. This notification can be utilized by the application.   
 
Low Battery 

If this box is checked, a notification that a low battery state has occurred is raised. The icon in the 
Toolbar in the emulated screen appears, too. The notification can be utilized by the application to 
recognize the low battery state in the hardware. 
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Indications 
The I/O Simulator expresses a change of state that occurred in the IT-300WM Device Emulator. 
 
LED 

When the IT-300WM Device Emulator turns on the LED, the LED icon (LED2) in the I/O 
Simulator also turns on. See Figure 7.12. 
 
Vibration 

When the IT-300WM Device Emulator vibrates, the vibration icon in the I/O Simulator also 
turns on. See Figure 7.12. 
 

 
Figure 7.12 
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7.3.3 Connecting via ActiveSync 
If debugging with the IT-300WM Device Emulator is carried out in Visual Studio 2008 or Visual 
Studio 2005, or transmission/reception of a file with the Device Emulator is carried out, 
ActiveSync must be used. 
 
Setting ActiveSync 

1. Start up ActiveSync and then navigate to File → Connection Settings …. 

 
Figure 7.13 
 

2. In Connection Settings screen, check in the Allow connections to one of the following 
box and choose DMA in the pull-down menu. See Figure 7.14. 

 
Figure 7.14 
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Connection via ActiveSync 

The way to establish connection of the Device Emulator via ActiveSync is; 
 
1. Start up the Device Emulator by referring to Chapter 7.2 "Starting Up the Device Emulator". 
2. Start up Visual Studio 2008 or Visual Studio 2005, and then navigate to Tools → Device 

Emulator Manager. Right-click IT-300WM Emulator in the list and then choose Cradle in 
the popup menu. See Figure 7.15. 

 
Figure 7.15 
 

3. Make sure ActiveSync has started up and the  icon in the status bar changes to the  icon. 
See the emulated screen of IT-300WM in Figure 7.16. The icon indicates that the connection via 
ActiveSync has been established. 

  
Figure 7.16     Figure 7.17 
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7.4 Debugging Applications 
This chapter describes how to debug your application using the Device Emulator. Before starting 
to "Build", establish a connection between the IT-300WM Device Emulator and your PC via 
ActiveSync by referring to Chapter 7.3 "Using the Device Emulator". 
For the basic order of developing an application, refer to Chapter 8 "Visual Studio". 
 
Setting Build Configuration 
Choose Debug in the Solution Configurations pull-down menu in Visual Studio 2008 or Visual 
Studio 2005 and IT-300WM Emulator in the target device pull-down menu. See Figure 7.18. 

 
Figure 7.18 

 
Debugging Applications 
Basic Debug Operation 

The debug operation used for the Device Emulator in Visual Studio 2008 or Visual Studio 
2005 is the same as an ordinary debug operation using the actual terminal. 

 
Debugging with the Device Emulator 

With the Device Emulator, it is possible to set a break point in the source code of the 
application for step-by-step debugging. 

 
1. Navigate to Debug menu → Start Debugging to start up the debugger. 

 
Figure 7.19 
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2. Similar to ordinary debugging operations with an actual IT-300, the Device Emulator allows 

break point setting (circled in red in Figure 7.20) in the source code and step-by-step debugging. 

 
Figure 7.20 
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8. Visual Studio 
This chapter describes application development steps in Visual Studio 2008 or Visual Studio 2005 to 
create an example program. The example program referred to in this chapter is an application 
program developed in three development environments - C++, Visual Basic and C# - using the 
CASIO Common Device Control Library or Common Device Control Class Library. The example 
program for all three environments repeats turning on and off the LED to brink for a period of 5 
seconds. See Chapters 8.1 "Developing in C++", 8.2 "Developing in VB" and 8.3 "Developing in 
C#" for each development environment. 
 
For the list of the libraries provided by the IT-300WM BDK, refer to Chapter 1.2 "Library". For 
detail about each function of the Common Device Control Library and Common Device Control 
Class Library, refer to Common Device Control Library Manual. 
 
The example program in this chapter runs also in the Device Emulator. To use the emulator, rename 
IT-300 Device to IT-300 Emulator. 
 
Notes: 
• Functions of the Common Device Control Library which control various individual devices 

integrated in the IT-300 have different name spaces and names from those available for the 
previous CASIO handheld terminals. They are not compatible with the ones in the previous 
CASIO library. The exceptions are DT-X7, DT-X11, and IT-600 that use the same libraries. 

• Applications developed with any functions of CASIO dedicated library must be rewritten by 
replacing the dedicated functions with the appropriate functions from the Common Device 
Control Library. 

• Take care when using Visual Studio 2008 or Visual Studio 2005 to upgrade an existing 
application and always keep a backup of your existing project. 
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8.1 Developing in C++ 
This chapter describes necessary steps to develop the example application program (see Chapter 8) 
in C++ environment using the Common Device Control Library. 
Before proceeding to creating the project, check if the installation folder for the Common Device 
Control Library has been registered in Visual Studio 2008 or Visual Studio 2005 by following steps, 
1 to 8, below. 
 
1. Navigate to Tools → Options … and open Options screen. 
2. Navigate to Projects and Solutions → Directories. 
3. Choose Windows Mobile 6 Professional SDK (ARMV4I) in Platforms. 
4. Choose Include files in Show directories for:. 
5. If the installation folder has not been registered, append the following. 

C:\Program Files\CASIO\MBSYS\include 
6. Choose Library files in Show directories for:. 
7. If the files have not been registered, append the following. 

C:\Program Files\CASIO\MBSYS\lib\ARMV4I 
8. Click OK button to close the screen. 
 
Application Development Procedure 
Subsequent steps show how to create and start up a simple program using one of the system 
functions. When running the program, the LED will blink in red for 5 seconds. 
 
1. First, create Win32 Smart Device Project with its device name SmartDeviceApp for Visual 

C++ in Visual Studio 2008 or Visual Studio 2005. 
2. Choose Pocket PC 2003 in the Selected BDKs (SDKs in the screen) field in the Platforms of 

Win32 Smart Device Project Wizard and click < button. 

 
Figure 8.1 
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Choose Windows Mobile 6.5.3 Professional SDK in the Installed SDKs field and click > 
button. 

 
Figure 8.2 

 
3. Click Next > button while IT-300 is kept being highlighted in the Selected SDKs field. 

 
Figure 8.3 
 
4. Choose Console Application for the Application type in the Application Settings menu, and click 

Finish button. 
5. In Solution Explorer, click SmartDeviceApp.cpp and then append the source code below 

subsequent to "#include <commctrl.h>". 
 

#include <SystemLib.h> 
#if !defined(_countof) 
#define _countof(_Array) (sizeof(_Array) / sizeof(_Array[0])) 
#endif 
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6. Append the source code below in the main function of SmartDeviceApp.cpp. 

    DWORD result; 
    TCHAR msg[16]; 
 
    result = SysSetLED(LED_RED, 5, 8, 8); 
 
    if(result == TRUE) 
    { 
        result = SysGetLED(); 
        switch(result & 0x0000000F) { 
        case LED_OFF: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_OFF") ); 
            break; 
        case LED_RED: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_RED") ); 
            break; 
        case LED_GREEN: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_GREEN") ); 
            break; 
        case LED_ORANGE: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_ORANGE") ); 
            break; 
        case LED_BLUE: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_BLUE") ); 
            break; 
        case LED_CYAN: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_CYAN") ); 
            break; 
        case LED_MAGENTA: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_MAGENTA") ); 
            break; 
        default: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_UNKNOWN") ); 
            break; 
        } 
        MessageBox(NULL, msg, TEXT("LED"), MB_OK); 
    } 
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7. Choose Properties in the Project of Visual Studio 2008 or Visual Studio 2005, and navigate to 

Configuration Properties → Linker → Input → Additional Dependencies and then 
append SystemLib.lib (see red circle in Figure 8.4). 

 
Figure 8.4 
 
8. Choose Windows Mobile 6.5.3 Professional Device for the Target Device to establish 

connection with the PC. 
9. Choose Debug in Visual Studio 2008 or Visual Studio 2005 and then click either Start Debugging 

or Start Without Debugging. 
10. The project will be built and copied to the "\Program Files\<name of project>" folder by default 

in the IT-300.  
11. Check that the program runs correctly on the IT-300. 
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8.2 Developing in VB 
This chapter describes necessary steps to develop the example application program (see Chapter 8) 
in VB environment using the Common Device Control Class Library. 
 
Application Development Procedure 
Subsequent steps show how to create and start up a simple program using one of the system 
functions. When running the program, the LED will blink in red for 5 seconds. 
 
1. Create a new VB Smart Device Application in Visual Studio. 
2. In Solution Explorer, right-click References and click Add Reference… 
3. Click Browse and navigate to the folder where you have stored the CASIO .NET library files. 

Highlight SystemLibNet.dll and click it to open. Click OK button. 

 
Figure 8.5 
 

4. Add a button to the form, rename it LED, and double click it. 
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5. In the event function for the button to click, add the following code. 

Dim result As Int32 
Dim msg As String 
 
result = Calib.SystemLibNet.Api.SysSetLED( _ 
            Calib.SystemLibNet.Def.LED_RED, 5, 8, 8) 
 
'.NET vales of "true" and "false" are "-1" and "0" respectively. 
If result = -1 Then 
    result = Calib.SystemLibNet.Api.SysGetLED() 
    Select Case (result And &HF) 
        Case Calib.SystemLibNet.Def.LED_OFF 
            msg = "LED_OFF" 
        Case Calib.SystemLibNet.Def.LED_RED 
            msg = "LED_RED" 
        Case Calib.SystemLibNet.Def.LED_GREEN 
            msg = "LED_GREEN" 
        Case Calib.SystemLibNet.Def.LED_ORANGE 
            msg = "LED_ORANGE" 
        Case Calib.SystemLibNet.Def.LED_BLUE 
            msg = "LED_BLUE" 
        Case Calib.SystemLibNet.Def.LED_CYAN 
            msg = "LED_CYAN" 
        Case Calib.SystemLibNet.Def.LED_MAGENTA 
            msg = "LED_MAGENTA" 
        Case Else 
            msg = "LED_UNKNOWN" 
    End Select 
    MessageBox.Show(msg, "LED") 
End If 

 
Note:  
If you type this code manually you should see the IntelliSense offer you suitable options as 
appropriate. If you do not, make sure you review steps 1 to 5 to make sure you have added the 
reference correctly. 

 
6. Choose Windows Mobile 6 Professional Device for the Target Device to establish 

connection with the PC. 
7. Choose Deploy <name of project> on Build menu. 
8. The project will be built and copied to the IT-300. By default, it will be copied to \Program 

Files\<name of project> folder. SystemLibNet.dll will be deployed to the same folder. 
9. Check that the program works correctly on the IT-300. 
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8.3 Developing in C# 
This chapter describes necessary steps to develop the example application program (see Chapter 8) 
in C# environment using the Common Device Control Class Library. 
 
Application Development Procedure 
Subsequent steps show how to create and start up a simple program using one of the system 
functions. When running the program, the LED will blink in red for 5 seconds. 
 
1. Create a new C# Smart Device Application in Visual Studio .NET. 
2. In Solution Explorer, right click References and click Add Reference… 
3. Click Browse and navigate to the folder where you have stored the CASIO .NET library files. 

Highlight SystemLibNet.dll and click Open. Click OK button. 

 
Figure 8.6 
 

4. At the top of your source file add the following code.  
using Calib; 
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5. Add a button to your form, rename it LED and double click it and then add the following code: 

Int32 result = new Int32(); 
string msg; 
 
result = SystemLibNet.Api.SysSetLED(SystemLibNet.Def.LED_RED, 5, 
8, 8); 
 
// .Net values "true" and "false" are "-1" and "0" respectively. 
if(result == -1) 
{ 
    result = SystemLibNet.Api.SysGetLED(); 
    switch(result & 0x0000000F)  
    { 
        case SystemLibNet.Def.LED_OFF: 
            msg = "LED_OFF"; 
            break; 
        case SystemLibNet.Def.LED_RED: 
            msg = "LED_RED"; 
            break; 
        case SystemLibNet.Def.LED_GREEN: 
            msg = "LED_GREEN"; 
            break; 
        case SystemLibNet.Def.LED_ORANGE: 
            msg = "LED_ORANGE"; 
            break; 
        case SystemLibNet.Def.LED_BLUE: 
            msg = "LED_BLUE"; 
            break; 
        case SystemLibNet.Def.LED_CYAN: 
            msg = "LED_CYAN"; 
            break; 
        case SystemLibNet.Def.LED_MAGENTA: 
            msg = "LED_MAGENTA"; 
            break; 
        default: 
            msg = "LED_UNKNOWN"; 
            break; 
    } 
    MessageBox.Show( msg, "LED"); 
} 

 
Note: 
If you add this code manually you should see the IntelliSense offer you suitable options as 
appropriate. If you do not see this, then review steps 2 to 4 in the previous page to make sure you 
have not made a mistake. 
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6. Choose Windows Mobile 6 Professional Device for the Target Device to establish 

connection with the PC. 
7. Select Deploy <name of project> on Build menu. 
8. The project will be built and copied to the IT-300. By default, it will be copied to \Program 

Files\<name of project> folder. SystemLibNet.dll will be deployed to the same folder. 
9. Check that the program works correctly on the device. 
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9. Resources 
Microsoft's own http://msdn.microsoft.com/mobility/ is an extremely comprehensive resource for 
programmers targeting WindowsCE .NET based devices. It includes links to most other useful web 
based resources. You will find detailed Software and Library manuals on 
http://world.casio.com/system/pa. 
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